**Important user information**

Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably trained personnel in accordance with applicable code of practice. If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

---

**WARNING:** Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss.

**ATTENTION:** Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

**Important:** Identifies information that is critical for successful application and understanding of the product.

Labels may also be on or inside the equipment to provide specific precautions.

**SHOCK HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present.

**BURN HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures.

**ARC FLASH HAZARD:** Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
# Table of contents

## Chapter 1

**Introduction**
- Intended audience ........................................................................................................ 7
- Where to find additional information ...................................................................... 7
- Help .............................................................................................................................. 7
- Release Notes ............................................................................................................. 8
- Training programs ..................................................................................................... 8
- Knowledgebases ...................................................................................................... 8
- Consulting services ................................................................................................ 8

## Chapter 2

**Welcome to FactoryTalk Gateway**
- What is FactoryTalk Gateway? .................................................................................. 9
- Overview of basic concepts ...................................................................................... 10
- FactoryTalk Services Platform ................................................................................ 10
  - FactoryTalk Directory ......................................................................................... 10
  - FactoryTalk Live Data ....................................................................................... 11
  - FactoryTalk Diagnostics .................................................................................... 11
  - FactoryTalk Administration Console ................................................................. 11
  - FactoryTalk Security .......................................................................................... 11
  - FactoryTalk Activation Manager ....................................................................... 11
- Local applications versus Network applications ....................................................... 11
- Quick start: Set up and use FactoryTalk Gateway ..................................................... 11

## Chapter 3

**Install FactoryTalk Gateway**
- System requirements ................................................................................................ 13
  - Hardware requirements ........................................................................................ 13
  - Hardware recommendations to support 70,000-tag configurations .................... 13
  - Software requirements ........................................................................................ 14
  - Software compatibility ........................................................................................ 15
  - Prerequisite software .......................................................................................... 15
- Where to install FactoryTalk Gateway ...................................................................... 16
- Install FactoryTalk Gateway ..................................................................................... 18
- Update an existing installation ................................................................................ 20
  - Before you begin ................................................................................................ 20
- Upgrade FactoryTalk Gateway ................................................................................ 20
- Install Remote FactoryTalk Gateway ....................................................................... 20

## Chapter 4

**Start FactoryTalk Gateway and explore the user interface**
- Start FactoryTalk Gateway ...................................................................................... 23
- About the FactoryTalk Gateway Configuration dialog box ...................................... 23
- About the FactoryTalk Gateway Scope Selection dialog box ............................... 25
# Chapter 5

**Use FactoryTalk Gateway to Access Data**

- Before you begin ............................................................................................................. 27
- Start FactoryTalk Gateway ............................................................................................ 27
- Select the scope .............................................................................................................. 28
- Access the data ............................................................................................................... 30

# Chapter 6

**Use FactoryTalk Diagnostics Counter Monitor with FactoryTalk Gateway**

- About FactoryTalk Diagnostics Counter Monitor ......................................................... 31
- Run FactoryTalk Diagnostics Counter Monitor .............................................................. 33
- Create a snapshot file ...................................................................................................... 34
- Use FactoryTalk Diagnostics Counter Monitor to troubleshoot FactoryTalk Gateway ................................................................. 35

# Chapter 7

**Troubleshoot FactoryTalk Gateway**

- What to check first if you have problems ....................................................................... 37
- Troubleshooting Tools .................................................................................................... 37
  - FactoryTalk Gateway Configuration dialog box .......................................................... 37
  - FactoryTalk Diagnostics .............................................................................................. 37
  - FactoryTalk Diagnostics Counter Monitor ................................................................. 38
  - Test Client .................................................................................................................... 38
  - OPC Test Client .......................................................................................................... 38
- Troubleshooting topics .................................................................................................... 38
  - FactoryTalk Gateway activations .................................................................................. 38
  - FactoryTalk Security ................................................................................................... 38
  - FactoryTalk Gateway service (starting and stopping) .................................................. 38
  - Data quality ................................................................................................................. 38
  - Communication slow or unreliable .............................................................................. 40
- Contact Rockwell Automation Technical Support ........................................................ 42
  - Phone ......................................................................................................................... 42
  - Worldwide web .......................................................................................................... 42
  - Hours of operation ..................................................................................................... 42
  - Before you call .......................................................................................................... 42

# Appendix A

**About Activations**

- Activate FactoryTalk Gateway ......................................................................................... 43
- About FactoryTalk Gateway activations ............................................................................ 44

# Appendix B

**Install FactoryTalk Gateway with command line syntax**

- Perform unattended installation ....................................................................................... 47
- Parameters ...................................................................................................................... 48
- Examples ......................................................................................................................... 49
# Appendix C

About RSLinx Enterprise

---

# Appendix D

About FactoryTalk Security

- Use FactoryTalk Security ............................................................ 53
- Secure the FactoryTalk Gateway Configuration tool .................... 53
- Secure runtime actions ............................................................... 54
- Secure tag write access ............................................................ 56

---

**Glossary**

**Index**

**Legal notices**
Introduction

The *Getting Results Guide* provides you with information on installing and using FactoryTalk® Gateway.

This chapter includes the following information:

- Intended audience
- Where to find additional information

**Tip:** The *Getting Results Guide* is included in a portable document format (PDF) on your FactoryTalk Gateway software installation DVD. These files must be viewed using the Adobe Acrobat Reader software, which is also included on the DVD.

### Intended audience

You should be familiar with:

- Microsoft Windows operating systems
- RSLinx Enterprise
- Allen-Bradley programmable logic controllers (PLCs)
- Rockwell Automation’s PLC programming tools

### Where to find additional information

For additional information about FactoryTalk Gateway, consult the following resources:

### Help

The Help includes all overview, procedural, screen, and reference information for the product. The Help contains these basic components:

- Overview topics
- Quick-start topics
- Step-by-step procedures
- Dialog box descriptions

To view the Help, click **Help** on the **FactoryTalk Gateway Configuration** dialog box.
Release Notes

The electronic Release Notes provide a list of the hardware and software that is necessary to use FactoryTalk Gateway effectively and a list of known anomalies and new features that are available in the current release of the software. The Release Notes are available in the Help or from the product installation DVD.

Training programs

Rockwell Automation offers a wide range of training programs, from regularly scheduled classes to custom-tailored classes conducted at your site.

If you would like more information about these training programs, visit the Rockwell Automation site on the Web or contact the Rockwell Automation Training Coordinator. The Web address and telephone numbers appear on page ii of this document.

Knowledgebases

The Rockwell Automation Customer Support Center offers an extensive online database that includes frequently asked questions and the latest patches. Please visit www.rockwellautomation/support, and select Knowledgebase under Self-Service Support.

Consulting services

Rockwell Automation provides expert consulting and turnkey implementations for making optimal use of Rockwell Software products. Please contact your local representative for more information.
Welcome to FactoryTalk Gateway

This chapter includes the following information:

- What is FactoryTalk Gateway?
- Overview of basic concepts
- Quick start: Set up and use FactoryTalk Gateway

What is FactoryTalk Gateway?

FactoryTalk Gateway is an OPC Data Access (OPC-DA) 2.05a-compliant OPC server. It enables OPC clients to connect to FactoryTalk® applications that contain RSLinx Enterprise and FactoryTalk View Site Edition (SE) servers and access tag data within those applications. FactoryTalk Gateway can send data to, and retrieve data from, any FactoryTalk Live Data server or OPC server that is defined within a FactoryTalk system.

Note:

- FactoryTalk Gateway service is started and stopped from the machine on which it is installed. However, FactoryTalk Gateway also supports launching the service from a remote client. If your application requires this, you will need to change the Distributed Component Object Model (DCOM) settings. You must be aware of the effect this may have on your system, because, in this case, the service can be stopped locally but re-started remotely. The default DCOM settings prohibit launching FactoryTalk Gateway remotely and is the recommended setup.

- FactoryTalk Gateway supports OPC client notification under normal shutdown conditions. However, it is the OPC client's responsibility to provide a mechanism to detect when it is no longer connected to the server and flag data as bad quality.

FactoryTalk Gateway consists of:

- A service that provides tag data to OPC clients.
- A configuration tool that configures the runtime operation of the service. The configuration tool enables you to select the area or application from which you want to access data (called the scope) as well as start and stop the service.

Use FactoryTalk Gateway if you need to use:
• RSLinx Enterprise as a data server for OPC clients.
• FactoryTalk View Site Edition as a data server for OPC clients to access HMI server tags (such as alarm, derived, and system tags) and direct references.

Only one FactoryTalk Gateway is permitted to run on a given computer. Your activation determines the maximum unique OPC items you can define, and you will be alerted via FactoryTalk Diagnostics and Diagnostic Counter Monitor when you have reached the maximum count. This count can be increased with additional activations. Refer to Appendix A for more information about activations.

FactoryTalk Gateway supports up to 20 OPC client connections and an unlimited number of unique tags depending on the activation.

For more information regarding OPC, refer to the OPC Foundation web site http://www.opcf.org.

Overview of basic concepts

Because FactoryTalk Gateway enables OPC clients to connect to FactoryTalk applications, it is important to understand some basic concepts about FactoryTalk. For more detailed information about FactoryTalk, refer to the FactoryTalk Help.

FactoryTalk Services Platform

Formerly known as FactoryTalk Automation Platform, the FactoryTalk Services Platform is an underlying architecture and set of services that Rockwell Automation software products build upon.

The FactoryTalk Services Platform:

• Provides common services (such as diagnostic messages, health monitoring services, access to real-time data) and shares plant resources (such as tags and graphics) throughout an automation system.
• Allows defining plant-floor resources once, and then allows simultaneous access to those resources across product boundaries.
• Supports centralized security services.

The FactoryTalk Services Platform includes the following components:

FactoryTalk Directory

FactoryTalk Directory allows products to share a common address book, which finds and provides access to plant-floor resources, such as data tags and graphics.

The FactoryTalk Services Platform includes two separate directories: a Local Directory and a Network Directory. In a Local Directory, a Directory Server, all project information, and all participating software products are located on a single computer. Local applications cannot be shared across a network. A Network Directory organizes project information from multiple FactoryTalk products across multiple computers on a network.
Welcome to FactoryTalk Gateway

Chapter 2

FactoryTalk Live Data

FactoryTalk Live Data manages connections between FactoryTalk products and data servers. It reads values from, and writes values to, OLE for Process Control - Data Access (OPC-DA) servers and Live Data servers on behalf of client software products, such as FactoryTalk View and FactoryTalk Transaction Manager.

FactoryTalk Diagnostics

FactoryTalk Diagnostics collects and provides access to activity, status, warning, and error messages generated throughout a FactoryTalk system.

FactoryTalk Administration Console

FactoryTalk Administration Console is an optional, stand-alone tool that enables you to configure and manage FactoryTalk-enabled applications.

FactoryTalk Security

FactoryTalk Security offers centralized security services that provides the ability to control access to your automation system. Your access to, and actions within, the FactoryTalk Gateway tool are controlled by FactoryTalk Security settings. Refer to Secure FactoryTalk Gateway using FactoryTalk Security on page 53 before attempting to configure FactoryTalk Gateway.

FactoryTalk Activation Manager

FactoryTalk Activation Manager provides a secure, software-based system for activating Rockwell Automation software products and managing software activation files.

Local applications versus Network applications

An application organizes project information, including elements such as data servers, HMI servers, and alarm and event servers, and makes it available to all FactoryTalk-enabled software products participating in a FactoryTalk system.

- **Network applications** are held in a FactoryTalk Network Directory. Project information and participating software products can be located on multiple computers distributed across a network. All of the computers participating in a particular Network application share a common Network Directory Server located on a network computer.

- **Local applications** are held in a FactoryTalk Local Directory. Project information is located on a stand-alone computer and is available only to software products installed on that same local computer. Local applications cannot be accessed remotely and cannot share project information with a Network application.

Quick start: Set up and use FactoryTalk Gateway

**Important:** If there is a possibility that a remote client can start the FactoryTalk Gateway service, you must disable the FactoryTalk Gateway service via the Windows Control Panel (and all of the OPC clients should be stopped or shut down) before you reconfigure the scope. This will prevent the service from automatically starting while you are making changes to the scope configuration. The default DCOM settings prohibit launching the FactoryTalk Gateway remotely and is the recommended setup.

Use the following checklist to guide you through the process of setting up and using FactoryTalk Gateway.
## Welcome to FactoryTalk Gateway

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Refer to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Read and understand the FactoryTalk Gateway Getting Results Guide.</td>
<td>System requirements on page 13</td>
</tr>
<tr>
<td>2.</td>
<td>Verify your personal computer meets the minimum hardware and software requirements.</td>
<td>Install FactoryTalk Gateway on page 13</td>
</tr>
<tr>
<td>3.</td>
<td>Install FactoryTalk Gateway.</td>
<td>About Activations on page 43</td>
</tr>
<tr>
<td>6.</td>
<td>Create a FactoryTalk application (or point to an existing application).</td>
<td>Your OPC client documentation.</td>
</tr>
<tr>
<td>7.</td>
<td>Add an RSLinx Enterprise data server or an HMI server.</td>
<td>“Add an RSLinx Enterprise server to an application” in the RSLinx Enterprise Help or “Add an HMI server to a network application” in the FactoryTalk View Site Edition Help.</td>
</tr>
<tr>
<td>9.</td>
<td>Select the scope using the FactoryTalk Gateway Scope Selection dialog box.</td>
<td>About the FactoryTalk Gateway Scope Selection dialog box on page 25</td>
</tr>
<tr>
<td>10.</td>
<td>Click Start Service on the FactoryTalk Gateway Configuration dialog box.</td>
<td>About the FactoryTalk Gateway Configuration dialog box on page 23</td>
</tr>
<tr>
<td>11.</td>
<td>When the OPC client makes a connection with FactoryTalk Gateway, enter FactoryTalk Gateway as the server name to which you wish to connect. If the OPC client supports browsing, select FactoryTalk Gateway from the list of available servers.</td>
<td>Your OPC client documentation.</td>
</tr>
<tr>
<td>12.</td>
<td>Run the OPC client and select the tags you want to access (up to, but not exceeding, the activation count).</td>
<td>Your OPC client documentation.</td>
</tr>
</tbody>
</table>
Chapter 3

Install FactoryTalk Gateway

The FactoryTalk Gateway installation DVD provides wizards to guide you through the installation process.

FactoryTalk Gateway supports two installation methods: Setup wizard installation and automated installation with command line syntax. This chapter uses the Setup wizard installation method to illustrate the steps. The automated installation with command line syntax reduces user interaction and provides command line parameters to install FactoryTalk Gateway. See Install FactoryTalk Gateway with command line syntax on page 47.

This chapter contains the following information:

- System requirements
- Where to install FactoryTalk Gateway
- Install FactoryTalk Gateway for the first time
- Update an existing system
- Install Remote FactoryTalk Gateway

System requirements

To use FactoryTalk Gateway, your personal computer must meet the following minimum hardware and software requirements:

Hardware requirements

To install FactoryTalk Gateway, you need the following hardware:

- Intel Core 2 Duo, 2.8 Ghz processor
- 2 GB of memory
- 16 GB free hard disk space

Hardware recommendations to support 70,000-tag configurations

To support large configurations (70,000 tags), select a computer based on the guidelines* below:
<table>
<thead>
<tr>
<th>Processor</th>
<th>Number of tags</th>
<th>Scan rate of all tags</th>
<th>Total CPU utilization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>70,000</td>
<td>All data changing value every 250 msec</td>
<td>75%</td>
</tr>
<tr>
<td>Dual-core</td>
<td>70,000</td>
<td>All data changing value every 250 msec</td>
<td>50%</td>
</tr>
<tr>
<td>Dual-core</td>
<td>70,000</td>
<td>All data changing value every 1000 msec</td>
<td>20%</td>
</tr>
</tbody>
</table>

*These guidelines are based on the results of tests using a dual-core Pentium D processor, 3 GHz, with 2G of RAM. The first test was run using only one of the dual-core processors to provide a basis for comparison. FactoryTalk Gateway and RSLinx Enterprise were installed and configured on this computer for the test.

The total amount of memory used for the runtime tests was approximately 700 MB. Additional memory would be utilized if browsing was done. Note that the largest impact of CPU utilization is the rate the data is changing and whether the data server (in this case, RSLinx Enterprise) is local or remote to the FactoryTalk Gateway.

**Software requirements**

FactoryTalk Gateway is tested on operating systems installed from original Microsoft media only. FactoryTalk Gateway runs on either the 32-bit or 64-bit versions of the following Windows operating systems:

- Windows 7 Enterprise with Service Pack 1
- Windows Embedded Standard 7 with Service Pack 1
- Windows 7 Home Premium with Service Pack 1
- Windows 7 Ultimate with Service Pack 1
- Windows 7 Professional with Service Pack 1
- Windows 8
- Windows 8 Enterprise
- Windows 8 Professional
- Windows 8.1
- Windows 8.1 Enterprise
- Windows 8.1 Professional
- Windows 10 Enterprise*
- Windows 10 Professional*
- Windows 10 IoT Enterprise 2016 Long Term Servicing Branch (LTSB) Embedded**
- Windows Server 2008 R2 Enterprise Edition with Service Pack 1
- Windows Server 2008 R2 Standard Edition with Service Pack 1
- Windows Server 2012 Datacenter
- Windows Server 2012 Standard Edition
- Windows Server 2012 R2 Datacenter
- Windows Server 2012 R2 Standard Edition

*See Rockwell Automation Knowledgebase Answer ID 964391 for Windows 10 support information.

**Supported with the Allen-Bradley 61xx family of Industrial Computers or CompactLogix™ 5480 family of controllers.

For the latest information regarding software platform support, refer to http://www.rockwellautomation.com/rockwellautomation/support/pcdc.page.

**Software compatibility**

FactoryTalk Gateway v3.90.00 (CPR 9 SR 9) has been tested with, and is compatible with, the following Rockwell Automation products when used on the same computer:

- FactoryTalk Services Platform v2.90.00
- FactoryTalk View v9.00.00
- RSLinx Classic v3.90.00
- RSLinx Enterprise v5.90.00

**Prerequisite software**

FactoryTalk Gateway Setup wizard supports to automatically install a series of Rockwell software and the necessary prerequisite software, including:

**Rockwell Software**

- FactoryTalk Gateway v3.90.00 (CPR 9 SR 9)
- FactoryTalk Services Platform v2.90.00 (CPR 9 SR 9)
- FactoryTalk Activation Manager v4.00.02
- FactoryTalk Alarms and Events v2.90.00 (CPR 9 SR 9)
- RSLinx Enterprise v5.90.00 (CPR 9 SR 9)
- Rockwell Automation USB CIP Driver v3.18.06 (for 32-bit operating systems)
- Rockwell Automation x64 Driver v2.00.00 (for 64-bit operating systems)
Prerequisite software

- Microsoft .NET Framework 4.6
- Microsoft SQL Server Compact 4.0 ENU v4.0.8482
- FactoryTalk Diagnostic v2.90.00 (CPR 9 SR 9)
- Windows Firewall Configuration Utility v1.00.08
- Wibu CodeMeter Runtime Kit v6.30

Where to install FactoryTalk Gateway

For FactoryTalk Local Directory applications, you must install FactoryTalk Gateway on the local computer.

In a FactoryTalk Local Directory application, all project information and security settings are located on a single computer, and the FactoryTalk-enabled system cannot be shared across a network. A FactoryTalk Gateway Local Directory, however, can support remote OPC clients. Products such as FactoryTalk View Site Edition (SE) Station and RSLinx Enterprise use the Local Directory.

Depending on your requirements, FactoryTalk Gateway installation options for Local FactoryTalk Directory applications include the following:

To use RSLinx Enterprise as a data server to HMI and other third-party OPC clients, FactoryTalk Gateway, RSLinx Enterprise, and FactoryTalk Directory are installed on the same machine as shown in the following diagram:

For FactoryTalk View Site Edition (SE) applications that need to serve OPC data, FactoryTalk View SE Station can also be installed on the same
machine, as shown in the following diagram. This also provides the benefit of FactoryTalk View SE Station features, such as alarm and derived tags and direct references. Plus, either RSLinx Enterprise or FactoryTalk View SE Station can be used as a data server.

For FactoryTalk Network Directory applications, you can install FactoryTalk Gateway on any computer.

A FactoryTalk Network Directory organizes project information and security settings from multiple FactoryTalk-enabled products across multiple computers on a network. When a Network Directory is configured on a computer, that computer can then be used as a Network Directory Server, or it can be made a client of a Network Directory Server configured on a different computer on the network. Products such as FactoryTalk View SE Distributed and FactoryTalk Transaction Manager use the Network Directory.

**Tip:** In FactoryTalk Network Directory applications, you can choose from multiple computers to install FactoryTalk Gateway. It is recommended that you install FactoryTalk Gateway and the client on the same computer, instead of using Remote OPC across the network. Because FactoryTalk Live Data is used as the network protocol in what is considered to be a more robust and secure fashion than Remote OPC.

Depending on your requirements, FactoryTalk Gateway provides many installation options for Network FactoryTalk Directory applications.

To connect to multiple RSLinx Enterprise servers or multiple FactoryTalk View Site Edition (SE) Distributed servers, FactoryTalk Gateway, RSLinx
Enterprise, and FactoryTalk Directory can be distributed over different machines, as shown in the following diagram:

![Diagram showing RSLinx Enterprise, FactoryTalk View SE, and Any OPC Client]

In this example, one FactoryTalk Gateway is serving all clients. If you require more than 70,000 tags, you can install a FactoryTalk Gateway on another machine or upgrade to Unlimited activation. If you plan to use 70,000 or more tags, refer to [Hardware recommendations to support 70,000-tag configurations](#) on page 13, for system requirements.

You can have multiple FactoryTalk Gateway servers point to the same scope in the same FactoryTalk Directory to provide redundancy for each other. The client code controls the switching between the FactoryTalk Gateway servers.

FactoryTalk Gateway supports redundant data servers and HMI servers. Refer to "About redundant servers for FactoryTalk systems" in the FactoryTalk Help for more information.

**Install FactoryTalk Gateway**

You can install one or more Rockwell Software products to a single personal computer.

**Important:** The user installing or configuring FactoryTalk Gateway must have administrative rights in Windows on the computers where the software is being installed or configured. The Windows domain Administrator account has these rights, for example.

To install FactoryTalk Gateway software:

1. Start your Windows operating system.
2. Insert the FactoryTalk Gateway DVD into the DVD-ROM drive.
3. On your Windows desktop, click **Start**, and then click **Run**. The **Run** dialog box appears.
4. In the Open control, type x:\setup, where x is the letter of the drive containing the FactoryTalk Gateway DVD-ROM, and then click OK.

5. If Microsoft .NET Framework 4.0 or later is not installed on your computer, the Microsoft .NET Framework Setup dialog box shows. Click Install.

6. On the FactoryTalk Gateway Setup dialog box, select which product you want to install from the product drop down list. The available products are:
   - Gateway
   - Remote Gateway

7. Choose one of the following:
   - Click Install Now to start the software installation with the default installation directory: C:\Program Files\Rockwell Software (for 32-bit operating systems) or C:\Program Files (x86)\Rockwell Software (for 64-bit operating systems).
   - Click Customize to specify a different drive where you want to install the FactoryTalk Gateway software, and then click Install.

8. On the End-User License Agreements dialog box, read the agreements, and click Accept all to continue the installation, or click Decline to return to the previous page.

9. When prompted to restart your computer during the installation, click Restart now to restart your computer and continue the installation, or Restart later to suspend and exit the installation.

10. If you are installing FactoryTalk Gateway, the Almost there dialog box shows. Select one of the following options, and click Next.
    - Select Activate your software to activate FactoryTalk Gateway now.
    - Select Skip activation to activate FactoryTalk Gateway later using FactoryTalk Activation Manager. For more information, refer to About Activations on page 43.

    If you are installing Remote Gateway, no activation is required.

11. On the That's it! dialog box, click Restart now to restart your computer and continue the installation, or Restart later to exit the installation. You must restart your computer before using FactoryTalk Gateway. Meanwhile, you can also:
• Click **Installation Summary** to see the installation details.
• Click **Register for updates** to learn how to receive email updates about product patches.
• Click **Download it free** to install Adobe Acrobat Reader. Adobe Acrobat Reader is required to open the *FactoryTalk Gateway Getting Results Guide* and other documents.

12. The FactoryTalk Gateway installation is complete. When you finish installing the software, remove the FactoryTalk Gateway DVD from the DVD-ROM drive, and store it in a safe place.

**Update an existing installation**

**Before you begin**

Note the following before upgrading FactoryTalk Gateway:

• The user installing or configuring FactoryTalk Gateway must have administrative rights in Windows on the computers where the software is being installed or configured. The Windows domain Administrator account has these rights, for example.

• If you upgrade from RSOPC Gateway CPR 7, do not use **Add/Remove Programs** from Windows **Control Panel** to uninstall RSOPC Gateway CPR 7. Using this method to remove RSOPC Gateway CPR 7 deletes CPR 7 RSOPC Gateway configuration files.

• You must install FactoryTalk Services Platform v2.90.00 (CPR 9 SR 9) to use FactoryTalk Gateway v3.90.00 (CPR 9 SR 9).

**Upgrade FactoryTalk Gateway**

Perform the following steps to upgrade to the latest version of FactoryTalk Gateway:

1. Stop the FactoryTalk Gateway service using the **Stop service** button on the **FactoryTalk Gateway Configuration** dialog box.

2. If FactoryTalk Diagnostics Counter Monitor is running, exit the program.

3. Close the **FactoryTalk Gateway Configuration** dialog box.

4. Insert the FactoryTalk Gateway product DVD. Perform the installation steps as presented on the screen.

5. Restart your computer.

**Note:** You must restart your computer after installing Rockwell Software products. If you are installing multiple products, you must restart your computer after all of the products are installed.

**Install Remote FactoryTalk Gateway**

Remote FactoryTalk Gateway enables an OPC client to access FactoryTalk Gateway on a remote computer without installing any Rockwell Automation products on this (local) computer. It is intended for those clients that do not
support server enumeration (that is, the ability to discover and identify FactoryTalk Gateway or other remote servers).

Remote FactoryTalk Gateway installs the OPC Foundation components, the OPC Test Client, and all registry information needed to connect to the remote FactoryTalk Gateway. Then you can use the OPC Test Client to test connections.

To install Remote FactoryTalk Gateway, select **Remote Gateway** on the **FactoryTalk Gateway Setup** dialog box of the Setup wizard, and follow the installation instructions provided.
Start FactoryTalk Gateway and explore the user interface

This chapter includes the following information:

- Starting FactoryTalk Gateway
- About the FactoryTalk Gateway Configuration dialog box
- About the FactoryTalk Gateway Scope Selection dialog box

Start FactoryTalk Gateway by selecting Start > Programs > Rockwell Software > FactoryTalk Gateway > FactoryTalk Gateway Configuration. (Or click on the FactoryTalk Administration Console menu bar.) The FactoryTalk Gateway Configuration dialog box opens. The default setting exposes all projects in the directory under the Network node.

Tip: To start or stop the FactoryTalk Gateway service, you must be either a Windows Administrator or Power User of the computer.

About the FactoryTalk Gateway Configuration dialog box

The FactoryTalk Gateway Configuration dialog box shows the activation, current operating state of the service, and the configured scope. It also provides a means to start and stop the service.

Note: If there is a possibility that a remote client can start the FactoryTalk Gateway service, you must disable the FactoryTalk Gateway service via the Windows Control Panel (or all of the OPC clients should be stopped or shut down) before you reconfigure the scope. This will prevent the service from automatically starting while you are making changes to the scope configuration. The default DCOM settings prohibit launching the FactoryTalk Gateway remotely and is the recommended setup.
The **FactoryTalk Gateway Configuration** dialog box contains the following information:

![FactoryTalk Gateway Configuration](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Shows the type of activation that is currently active. See &quot;About Activations&quot; on page 45 for information about activations.</td>
</tr>
</tbody>
</table>
| 2    | Shows the state of the FactoryTalk Gateway service:  
  - Running: Service is running.  
  - Starting: Service is starting.  
  - Stopped: Service is not running.  
  - Stopping: Service is stopping. |
| 3    | Shows the area within FactoryTalk Directory that has been selected using the **FactoryTalk Scope Selection** dialog box. If the scope has not been configured, this field is blank. Shows error messages if there are errors obtaining the scope or if the scope does not correspond with the activation. |
| 4    | Click **Configure** to access the **FactoryTalk Gateway Scope Selection** dialog box. You must stop the service (click **Stop Service**) before you can configure the scope. Note that if you do not have read permission and you click **Configure**, an error message opens. You must also be logged in to FactoryTalk to be able to configure the scope. You will be prompted to log in when you click **Configure** if you have not already done so.  
Refer to **Secure FactoryTalk Gateway using FactoryTalk Security** on page 53 regarding the permissions required to configure the scope. |
| 5    | Click **Start Service** to start the FactoryTalk Gateway service. This option is unavailable when the service is running or starting.  
Note that if the service has been disabled via the Windows **Control Panel** while the FactoryTalk Gateway user interface is opened, you will not be able to start the service using the **Start Service** button. You must start the service from the Windows **Control Panel**. If you launch the FactoryTalk Gateway user interface after disabling the service, the **Selected Scope** box shows an error message.  
Refer to **Secure FactoryTalk Gateway using FactoryTalk Security** on page 53 regarding the permissions required to start the service. |
### Item Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>6</strong></td>
<td>Click <strong>Stop Service</strong> to stop the FactoryTalk Gateway service. This option is unavailable when the service is stopping or stopped. When you click <strong>Stop Service</strong>, you will be asked to confirm this action, and you will be able to cancel the stop command at that time, if desired. Refer to <a href="#">Secure FactoryTalk Gateway using FactoryTalk Security</a> on page 53 regarding the permissions required to stop the service.</td>
</tr>
<tr>
<td><strong>7</strong></td>
<td>Click <strong>Help</strong> to access the FactoryTalk Gateway Help.</td>
</tr>
</tbody>
</table>

---

**About the FactoryTalk Gateway Scope Selection dialog box**

When you stop the FactoryTalk service and click **Configure** on the FactoryTalk Gateway Configuration dialog box, FactoryTalk Gateway browses for and shows the current configuration in the FactoryTalk Gateway Scope Selection dialog box.

**Tip:**

- The FactoryTalk Gateway Scope Selection dialog box provides a snapshot of the FactoryTalk Directory at the time FactoryTalk Gateway was started. Changes made to the configuration in FactoryTalk View Studio or FactoryTalk Administration Console are not automatically reflected in the FactoryTalk Gateway Scope Selection dialog box.
- If the server scope is changed up or down a level, OPC clients may not be able to access tags from the original configuration. This is because the OPC browse interface provides tag names that are relative to the FactoryTalk Gateway’s configured scope. If you change an existing configuration, you will be prompted to verify that you want to change the scope.
- You must stop the service (click **Stop Service**) before you can configure the scope. Note that if you do not have read permission and you click **Configure**, an error message opens. Refer to “Considerations when using FactoryTalk Gateway with FactoryTalk Security” in the FactoryTalk Gateway Help. You must be logged into FactoryTalk to be able to configure the scope. If you have not already done so, you will be prompted to log in when you click **Configure**.
- To modify the scope, use the FactoryTalk Administration Console.
The **FactoryTalk Gateway Scope Selection** dialog box contains the following information:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The <strong>FactoryTalk Gateway Scope Selection</strong> dialog box shows the root directory name, the application names, areas, and sub-areas (collectively called the scope) within the FactoryTalk Directory for which the FactoryTalk Gateway is activated (local or network). When the dialog box is opened for the first time, the root directory is selected. Once a configuration has been created and saved, the dialog box shows the last configuration selected. Click any child node of the root of the tree to select it.</td>
</tr>
<tr>
<td>2</td>
<td>Shows the last configuration selected.</td>
</tr>
<tr>
<td>3</td>
<td>The <strong>OK</strong> button is enabled when a new scope has been selected. Click <strong>OK</strong> to save the new configuration. If a scope has been saved previously, you will be prompted to verify that you want to save the new configuration. TB1. Click <strong>Yes</strong> to save the new scope and overwrite the previously saved scope. TB2. Click <strong>No</strong> to close the Scope Selection dialog box without saving any changes to the scope.</td>
</tr>
<tr>
<td>4</td>
<td>Click <strong>Close</strong> to close the <strong>FactoryTalk Gateway Scope Selection</strong> dialog box.</td>
</tr>
<tr>
<td>5</td>
<td>Click <strong>Help</strong> to access the FactoryTalk Gateway Help files.</td>
</tr>
</tbody>
</table>
Use FactoryTalk Gateway to Access Data

This chapter includes the following information:

- Before you begin
- Starting FactoryTalk Gateway
- Selecting the scope
- Accessing data

Before you begin

Before you can access data via FactoryTalk Gateway, you must:

1. Install and activate FactoryTalk Gateway.
   
   For the detailed steps, refer to Chapter 3: Install FactoryTalk Gateway and Appendix A: About activations of this guide.

2. Create a FactoryTalk application, or point to an existing application, in FactoryTalk Administration Console.
   
   For the detailed steps, refer to Quick Start: Setting up a FactoryTalk system in the FactoryTalk Services Platform Online Help.

3. Add a data server, for example, an RSLinx Enterprise data server.
   
   For the detailed steps, refer to Create a Network application and add servers in the FactoryTalk Services Platform Online Help.

4. Add shortcuts to target controllers in RSLinx Enterprise.
   
   For the detailed steps, refer to Create a shortcut in the RSLinx Enterprise Online Help.

Start FactoryTalk Gateway

Start FactoryTalk Gateway by selecting Start > Programs > Rockwell Software > FactoryTalk Gateway > FactoryTalk Gateway Configuration. (Or, click on the FactoryTalk Administration Console menu bar.) The FactoryTalk Gateway Configuration dialog box opens.
Tip: To start or stop the FactoryTalk Gateway service, you must be either a Windows Administrator or Power User of the computer.

Select the scope

The scope is the area or application from which you want to access data. The main FactoryTalk Gateway Configuration dialog box shows the current scope. The default setting selects all of the projects in the directory under the Network node.

Note:
- If there is a possibility of a remote or local client requesting tag data from FactoryTalk Gateway, you must disable the FactoryTalk Gateway service via the Windows Control Panel, or stop or shut down all of the OPC clients before you reconfigure the scope. This will prevent the service from automatically starting while you are configuring the scope. The default DCOM settings prohibit launching the FactoryTalk Gateway remotely and is the recommended setup.
- You must stop the service (click Stop service) before you can configure the scope. Note that if you do not have read permission and you click Configure, an error message opens. Refer to “Considerations when using FactoryTalk Gateway with FactoryTalk Security” in the FactoryTalk Gateway Help. You must be logged into FactoryTalk to be able to configure the scope. If you have not already done so, you will be prompted to log in when you click Configure.
- When using a new system, or if you need to change the scope, use the FactoryTalk Administration Console.

To select the scope:

1. Click Stop service on the FactoryTalk Gateway configuration dialog box.

2. Click Configure... The FactoryTalk Gateway Scope Selection dialog box opens. If you have not already done so, you will also be prompted to log in to FactoryTalk.

3. Click an application, area, or sub-area within which you want to access tag data. You can select only one project scope at a time (that is, application, area, or sub-area off of the root node). You cannot select the root node.
Select the largest possible scope to avoid the need to reconfigure it later. For example, the following scope selection allows you to access data within the Waste Water area only.

By selecting the application Samples Water, you can access the data within all of the areas in that application.

The **Scope Selected** field shows your selection. Click **OK** to save the scope you selected and close the dialog box.
Tip: If the server scope is changed up or down a level, OPC clients may not be able to access tags from the original configuration. This is because the OPC browse interface provides tag names that are relative to the FactoryTalk Gateway’s configured scope. If you change an existing configuration, you will be prompted to verify that you want to change the scope.

Access the data

Your access to, and actions within, the FactoryTalk Gateway tool are controlled by FactoryTalk Security settings. Refer to Secure FactoryTalk Gateway using FactoryTalk Security on page 53 before attempting to configure FactoryTalk Gateway.

To access data using FactoryTalk Gateway:

1. If the service is not already running, click Start service on the FactoryTalk Gateway Configuration dialog box to start the service. By default, the service is started automatically and is always running once FactoryTalk Gateway is launched.

   Tip: If the service has been disabled via the Windows Control Panel while the FactoryTalk Gateway user interface is opened, you will not be able to start the service using the Start service button. You must start the service from the Windows Control Panel.

2. Run the OPC client. When the OPC client makes a connection with FactoryTalk Gateway, enter FactoryTalk Gateway as the server name you want to connect to. If the OPC client supports browsing, select FactoryTalk Gateway from the list of available servers.

3. Using the OPC client, add a Group.

4. Using the OPC client, add Items from the selected scope (up to, but not exceeding, the activation count).

Refer to your OPC client documentation for more information.
Use FactoryTalk Diagnostics Counter Monitor with FactoryTalk Gateway

This chapter includes the following information:

- About FactoryTalk Diagnostics Counter Monitor
- Run FactoryTalk Diagnostics Counter Monitor
- Create a snapshot file
- Use FactoryTalk Diagnostics Counter Monitor to troubleshoot FactoryTalk Gateway

About FactoryTalk Diagnostics Counter Monitor

FactoryTalk Diagnostics Counter Monitor is installed with FactoryTalk Services Platform. This stand-alone tool shows diagnostic counter information as well as OPC clients, groups, and corresponding items.

FactoryTalk Diagnostics Counter Monitor shows diagnostic information about the FactoryTalk Gateway runtime operation:

- Diagnostic counters are displayed as properties at the FactoryTalk Gateway, client, and group levels.
- Individual diagnostic items are displayed as children of their corresponding group connection.

Tip: FactoryTalk Diagnostics Counter Monitor shows diagnostics for FactoryTalk Gateway, FactoryTalk Live Data, and RSLinx Enterprise (if installed).
The FactoryTalk Diagnostics Counter Monitor main window contains three areas:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | **Navigator**  
Workstations are manually added to or removed from a tree in the Navigator area. If RSLinx Enterprise or FactoryTalk Gateway is installed on a workstation, FactoryTalk Diagnostics Counter Monitor automatically detects and shows them on the tree under the associated workstation. |
| 2    | **Data**  
The values of the selected diagnostic items are displayed in the Data area.  
The Data area contains the following columns:  
- **Name**: At the root, provider, and client levels, this is the name of the diagnostic counter. At the group level, this is the tag name.  
- **Value**: At the root and provider levels, this is the returned data value of the diagnostic counter. At the group level, this indicates the status of the tag: Active or Inactive.  
Note that neither the list of names nor their values can be modified.  
For a description of each counter, refer to the FactoryTalk Diagnostics Counter Monitor Help. |
Run FactoryTalk Diagnostics Counter Monitor

Item Description

3 Viewer, which contains two tabs:
- **Troubleshooting Resources**
  The Help is integrated into FactoryTalk Diagnostics Counter Monitor using this viewer.
- **FactoryTalk Diagnostics Messages**
  Error messages associated with FactoryTalk Diagnostics Counter Monitor are logged to FactoryTalk Diagnostics. These messages are also displayed on the FactoryTalk Diagnostics Messages viewer. This enables you to see if there is any correlation between the logged messages and the values of the diagnostic items displayed in the Data area. Note that FactoryTalk Diagnostics messages are displayed for the local workstation only.

To further aid in diagnosing problems, an **integrated snapshot feature** captures diagnostic values into an .xml file. This enables you to send this information to Rockwell Automation Technical Support if you need troubleshooting assistance. Refer to [Create a snapshot file](#) on page 34.

**Tip:**
FactoryTalk Diagnostics Counter Monitor is currently supported for desktop servers only. Windows CE is not supported in this release.

Keep the following in mind while using FactoryTalk Diagnostics Counter Monitor:

- Inactive tags are displayed with a value of Inactive.
- If a group's state is inactive, then the items within that group are inactive, regardless of what appears on the screen. However, if a group's state is active, it does not affect the state of any items within that group; that is, items within that group may be active or inactive.
- If client and group names are supplied by the client, then those names will be shown in the FactoryTalk Diagnostics Counter Monitor Navigator area.
- Duplicate items are given a numerical suffix (that is, itemname (#)) to distinguish them and are treated as unique tags. Duplicate items are numbered sequentially as they are added, regardless of the Group to which they are added. For more information, refer to the Duplicate items counter description in the Help.

Note the following before you begin using FactoryTalk Diagnostics Counter Monitor:

- FactoryTalk Gateway must be installed and running on one or more host computers on the network.
- The diagnostics client must have access to a workstation that has an application with diagnostic items associated with it. A client must be accessing those diagnostic items in order for them to be shown on FactoryTalk Diagnostics Counter Monitor.
To prevent FactoryTalk Gateway performance degradation, run only one instance of FactoryTalk Diagnostics Counter Monitor at a time, and close the tool when you have finished troubleshooting.

To run FactoryTalk Diagnostics Counter Monitor:

1. Start FactoryTalk Diagnostics Counter Monitor.

   Click Start > Programs > Rockwell Software > FactoryTalk Tools > FactoryTalk Diagnostics Counter Monitor.

   The FactoryTalk Diagnostics Counter Monitor main window opens. By default, the Navigator area shows a single root item called System Diagnostics.

2. Add a workstation to the Navigator area.

   Right-click on the root in the Navigator area, and select Add Workstation. The Enter Workstation IP Address/Hostname dialog box opens.

   Tip: Alternately, you can add a workstation by clicking the root in the Navigator area and clicking .

   Enter the hostname or the device name of the workstation that contains the diagnostics you want to view, and click OK. For more information about the Enter Workstation IP Address/Hostname dialog box, refer to the Help.

   Note that the default workstation is localhost.

3. Expand the workstation to expose the installed data provider(s).

4. Click on any diagnostic item in the tree. The diagnostic counters associated with the selected item are shown in the Data area of the FactoryTalk Diagnostics Counter Monitor main window. While the item is selected, the counter values are updated automatically as new values are received.

Create a snapshot file

Snapshot files aid in troubleshooting by capturing all diagnostic values in an .xml file, which can then be sent to Rockwell Automation Technical Support. The .xml file contains the values of all of the diagnostic counters, whether expanded and displayed or not. Refer to “About the snapshot file” in the FactoryTalk Gateway Help for more information.

To create a snapshot file:

1. Click File > Save Snapshot.

2. Select the location to which you want to save the snapshot file. The default location is the C: drive.
3. Enter a filename, or use the default filename, *FTDiagData.xml*.

4. Click **Save**.

To use FactoryTalk Diagnostics Counter Monitor to troubleshoot FactoryTalk Gateway:

1. Start FactoryTalk Gateway. *(Start > Programs > Rockwell Software > FactoryTalk Gateway > FactoryTalk Gateway Configuration or click on the FactoryTalk Administration Console menu bar.)*

2. Start FactoryTalk Diagnostics Counter Monitor. *(Start > Programs > Rockwell Software > FactoryTalk Tools > FactoryTalk Diagnostics Counter Monitor.)*

3. Click **FactoryTalk Gateway** in the FactoryTalk Diagnostics Counter Monitor **Navigator** area.

The first five counters displayed in the Counter area provide a basic high-level view of the status of the FactoryTalk Gateway's interactions with the clients:

- **Activation**: Verify the value indicates the correct activation.
- **Count against Activation**: Verify there are tags present (value > 0).
- **Service Status**: Verify the service is Running.
- **Selected Scope**: Verify the scope is correct for your application.
- **Data Callbacks**: Verify that tags are updating (values increase). If tags are not updating, there are a number of possible reasons:
  - The data values are static.
  - The controller is in **PROGRAM** mode.
  - Groups or items at the client level are inactive.

4. Click the **FactoryTalk Diagnostics Messages** tab in the **Viewer** area. For more information about using this resource, refer to the FactoryTalk Diagnostics Counter Monitor Help.
Chapter 7

Troubleshoot FactoryTalk Gateway

This chapter includes the following information:

- What to check first if you’re having problems
- Troubleshooting tools for FactoryTalk Gateway
- Troubleshooting topics
- How to contact technical support

What to check first if you have problems

Does your FactoryTalk Diagnostics Counter Monitor meet the minimum hardware and software requirements? Refer to Install FactoryTalk Gateway on page 13 for these requirements.

Is the software installed correctly? Refer to Install FactoryTalk Gateway on page 13 for installation instructions. Restart your computer after installing the software before you begin using FactoryTalk Gateway.

Do you have a valid activation file? Check the FactoryTalk Diagnostics log. An information message is logged if the activation file is not detected by the system when you launch FactoryTalk Gateway. Refer to the FactoryTalk Help for information about FactoryTalk Diagnostics messages. Refer to About Activations on page 43 for information about activations.

To help you isolate, diagnose, and correct any problems you may experience using FactoryTalk Gateway, use the following troubleshooting tools:

The Selected Scope field on the FactoryTalk Gateway Configuration dialog box shows error messages. These messages are described in the FactoryTalk Gateway Help.

FactoryTalk Diagnostics provides the ability to log errors, warnings, and other status messages generated throughout a FactoryTalk-enabled system to a central location called an event log. If you encounter a problem, you can review the events in the log that led up to the problem to assist in determining the cause. Or, you can monitor the log to identify potential problems and take corrective action before a problem occurs.

Note that FactoryTalk Diagnostics messages are displayed for the local workstation only.

Refer to the FactoryTalk Help for more information about FactoryTalk Diagnostics and the event log. Refer to the FactoryTalk Gateway Help for
more information about diagnostic messages specific to FactoryTalk Gateway.

FactoryTalk Diagnostics Counter Monitor

FactoryTalk Diagnostics Counter Monitor aids in troubleshooting OPC connections from third-party products. It shows diagnostic information about the FactoryTalk Gateway runtime operation. The FactoryTalk Diagnostics event log and Help are integrated into this tool. Refer to Use FactoryTalk Diagnostics Counter Monitor with FactoryTalk Gateway on page 31 for more information. Refer to the FactoryTalk Diagnostics Counter Monitor Help for individual counter descriptions.

Test Client

FactoryTalk Live Data Test Client is a utility that enables you to test your OPC connection after you have configured the FactoryTalk Gateway. This utility is installed automatically with FactoryTalk Services Platform.

OPC Test Client

OPC Test Client is a utility that enables you to test your data connections if you are using remote OPC Client functionality. This utility is installed automatically as part of Remote FactoryTalk Gateway on the FactoryTalk Gateway product DVD.

Troubleshooting topics

FactoryTalk Gateway activations

The topics below provide information to help you troubleshoot FactoryTalk Gateway.

If you are experiencing activation problems, refer to:

- "About FactoryTalk Gateway activation" in the FactoryTalk Gateway Help, or refer to About Activations on page 43.
- "Activation errors" in the FactoryTalk Gateway Help.
- FactoryTalk Activation Manager troubleshooting topics in the FactoryTalk Help.

FactoryTalk Security

If you are experiencing problems with FactoryTalk Security, refer to:

- Troubleshooting topics in the FactoryTalk Help.

FactoryTalk Gateway service (starting and stopping)

If you are experiencing problems starting or stopping the FactoryTalk Gateway service, verify your Windows user account privileges. You must have administrative rights to start and stop the service.

If you are experiencing problems with bad quality data, no data being returned, data is stale or frozen, or tags do not appear during an OPC client tag browse operation, use the following steps to isolate and correct the problem:

1. Verify that the FactoryTalk connection is working using FactoryTalk Live Data Test Client to connect directly to FactoryTalk (not FactoryTalk Gateway).
a. Verify that you can browse and add an item. If there are no problems, then the issue is with FactoryTalk Gateway, not FactoryTalk.

2. Test the connection.
   
a. Run OPC Test Client or FactoryTalk Live Data Test Client. Note that you may need to change the DCOM settings if you use OPC Test Client.

   b. Navigate to the application containing the data server that you are trying to use.

   c. Browse, and put some tags on scan. If you cannot browse for tags, then the data server is not configured correctly or the devices that the data server is pointing to are not configured or connected.

3. Verify that the tags are not hidden by the External Access attribute (set in Logix Designer, starting with version 18 for controllers that support External Access). For more information on the External Access attribute, refer to the documentation for version 18 (CPR 9 SR 2) or later of the application. Note that if the External Access attribute for a tag in a controller is changed from None to Read or Read/Write, you may need to restart the data client to see the tag. If the External Access attribute for a tag in a controller is changed from Read or Read/Write to None, the Quality changes to Out of Service for that tag.

4. Check the FactoryTalk Gateway configuration.
   
a. Open FactoryTalk Gateway.

   b. Verify that the server is running. If you are experiencing stale or frozen data, it is possible that the client was not notified that FactoryTalk Gateway service had stopped.

   c. Verify that the proper application, including scope (network or local), is selected.

   d. Verify that you have the correct activation for the application you are trying to run.

5. Check the FactoryTalk Diagnostics log. Some events to check for:

   a. A controller is in the process of downloading a new program. The FactoryTalk Diagnostics log will indicate if a new program has been downloaded and specify the path.

   b. The activation is incorrect for the application or you have exceeded the activation count.
The tag does not exist. Any currently non-existing tags should be logged as not existing in the controller.

6. Check the RSLinx Enterprise configuration.
   a. Open FactoryTalk Administration Console or FactoryTalk Studio.
   b. Right-click the RSLinx Enterprise server and select Properties. Verify the correct computer hosting RSLinx Enterprise is shown.
   c. Double-click Communication Setup.
   d. Verify that there is a shortcut configured and that it has the correct name.
   e. Click the shortcut and verify that it is pointing to the expected device within the communication tree.
   f. SS6. Right-click the network you are using and select Start Browsing. If the device disappears from the Communication tree, then RSLinx Enterprise is no longer finding the device. Verify that the device is online.

7. Verify that DCOM and the Windows firewall are configured correctly.

8. Verify that the scope and RSLinx Enterprise shortcuts are correctly configured. Refer to Use FactoryTalk Diagnostics Counter Monitor to troubleshoot FactoryTalk Gateway on page 31.

If the above steps do not resolve your problem, please contact Rockwell Automation Technical Support.

There are many factors to consider when diagnosing communication problems:

- Computer effect on communication
  - Memory, disk space, and anti-virus scans can affect computer performance. Refer to System requirements on page 13.
  - Firewalls and switches can completely or partially block communication.
  - The typical timing factor for communication updates is the CPU load. Rockwell Automation recommends a 40% maximum steady state CPU loading. This balances utilization of the hardware and gives enough bandwidth for peak loading.

- Multiple clients effect on communication
• The packaging of data to OPC standards takes computer CPU power to achieve, and this can be significant depending on the data loading.

• The number of clients requesting data from a single OPC data server can also significantly impact computer CPU loading, particularly if they are not requesting the same items (tags).

• Clients creating and destroying groups can significantly impact CPU usage.

• **Network effect on communication**

  An incorrect network configuration can reduce communication effectiveness. Verify your network configuration as well as your installation. Refer to Install FactoryTalk Gateway on page 13.

• **Controller effect on communication**

  For ControlLogix controllers, data requests are handled by a CPU separate from the control program CPU. (FlexLogix controllers have one CPU to handle all tasks.) However, eventually these data requests are handled by the controller program. This affects communication efficiency since the controller is performing higher priority tasks and handles communication when CPU time is available. You can monitor task utilization using Logix5000 Task Monitor on the Logix Designer utilities DVD.

  Data requests are sent to controllers via a network port (for example, Ethernet, ControlNet, DeviceNet). For ControlLogix Ethernet communication, the ENET, ENBT, EN2T, or EWEB module is required. These modules could be a bottleneck to communication depending on the number of data requests and the number of requesting clients.

  Tag structure in a controller program can also have a significant impact on communication efficiency. Refer to your Logix Designer documentation.

  The communication time slice setting within the controller (set using Logix Designer application) will affect communication. You may need to increase the setting value.

  The way OPC clients request data can either help or hinder the ControlLogix Optimized Packets process. Refer to your ControlLogix controller documentation.

• **DCOM effect on communication**

  OPC is based on DCOM, therefore:
- Changing DCOM security settings can stop OPC from working.
- If the server and client become disconnected (either via a physical network disconnect or a software disconnect), there is a hard-coded 6-minute time-out notification.
- If the server and client are reconnected, the OPC connection is not automatically reconnected to the original objects. Therefore, servers and clients may require restarting.

Contact Rockwell Automation Technical Support

If you are experiencing a problem with, or have a question about, FactoryTalk Gateway, please consult the Help and Release Notes. If you cannot find the answer, contact Rockwell Automation Technical Support.

440-646-3434

http://www.rockwellsoftware.com

http://support.rockwellautomation.com

Hours of operation

Support staff are available 8 a.m. to 5 p.m. EST, Monday through Friday, except holidays.

Before you call

Before you call, you should be at your computer and be prepared to give the following information:

- The product serial number and version number. These can be found by clicking Start > Settings > Control Panel > Add/Remove Programs and clicking FactoryTalk Gateway.
- The type of hardware you are using.
- The version of Windows operating system you are using.
- The exact wording of any messages that appeared on your screen.
- What happened and what you were doing when the problem occurred.
- How you tried to solve the problem.
About Activations

Rockwell Automation Windows-based software products are copy protected and require an activation key, located in an activation file, to run the software.

When you launch FactoryTalk Gateway, the software checks for the activation file. If the system fails to detect the activation file, an error is logged to FactoryTalk Diagnostics, and the system operates under a grace period. Refer to the FactoryTalk Diagnostics Help for more information about diagnostic messages.

This appendix includes the following information:

- Activating FactoryTalk Gateway
- About FactoryTalk Gateway activations

FactoryTalk Gateway v3.70.00 (CPR 9 SR7) and later support to activate software during the software installation. The new Installation Setup Wizard contains an Activate products using FactoryTalk Activation check box. This no longer requires you to open FactoryTalk Activation Manager to activate the software.

To activate your copy of FactoryTalk Gateway in the FactoryTalk Gateway Installation Setup Wizard, perform the following steps:

1. Perform the steps in Install FactoryTalk Gateway on page 13 to install FactoryTalk Gateway software.


3. On the Software Activation dialog box, enter the product key from your Activation Certificate. The serial number should have been automatically added. If the serial number is not automatically added, enter the serial number.

4. Select Activate locally to activate FactoryTalk Gateway on a single computer, or select Activate using a dongle to activate FactoryTalk Gateway on any computer by using a dongle.
Appendix A  About Activations

Tip: The Activate using a dongle option requires that you have a dongle to lock the activation.

5. Click **Continue**.

You can still activate FactoryTalk Gateway via FactoryTalk Activation Manager by clicking the **Explore other options** link in the **Software Activation** dialog box. The link provides direct access to the FactoryTalk Activation Manager software. To activate your copy of FactoryTalk Gateway in the FactoryTalk Activation Manager, click **Get New Activations** and follow the instructions in the FactoryTalk Activation Manager.

For more information on using the FactoryTalk Activation Manager, click **More** or **Help** in the FactoryTalk Activation Manager.

EvRSI activation is replaced by FactoryTalk Activation Manager. If you are using EvRSI activation, please contact your local Rockwell Automation Sales office or Technical Support for information on migrating your activations to FactoryTalk Activation Manager.

For Rockwell Automation Technical Support in the U.S., call (440) 646-3434.

Outside the U.S., visit http://www.rockwellautomation.com/locations.

**About FactoryTalk Gateway activations**

FactoryTalk Gateway requires an activation for operation. The activation determines the maximum number of unique tags that can be added to the server.

If a valid activation cannot be found, FactoryTalk Gateway will operate under a grace period. Refer to the FactoryTalk Help for more information about grace periods.

**Tip:** You can check the number of tags you have added to the server using FactoryTalk Diagnostics Counter Monitor and checking the Count against Activation counter.

The types of activations and their maximum number of tags is shown in the following table:

<table>
<thead>
<tr>
<th>Product</th>
<th>Activation</th>
<th><strong>Maximum number of unique tags</strong></th>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>FactoryTalk Gateway Distributed</td>
<td>Network Unlimited</td>
<td>Unlimited</td>
<td>Local/Network</td>
</tr>
<tr>
<td>FactoryTalk Gateway Distributed</td>
<td>Network 70000</td>
<td>70,000</td>
<td>Local/Network</td>
</tr>
</tbody>
</table>
### About Activations

<table>
<thead>
<tr>
<th>Product</th>
<th>Activation</th>
<th>Maximum number of unique tags*</th>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>FactoryTalk Gateway Distributed</td>
<td>Network 32000</td>
<td>32,000</td>
<td>Local/Network</td>
</tr>
<tr>
<td>FactoryTalk Gateway Distributed</td>
<td>Network 5000</td>
<td>5,000</td>
<td>Local/Network</td>
</tr>
</tbody>
</table>

*The tag count includes active, inactive, and valid tags.

You can install multiple activations on one computer. FactoryTalk Gateway will use the activation that allows the largest scope. In order of precedence, FactoryTalk Gateway checks for Network 70000, Network 32000, and Network 5000.

If you require more than 70,000 tags, you can install a FactoryTalk Gateway on another machine or upgrade to Network Unlimited activation. If you plan to use 70,000 or more tags, refer to [Hardware recommendations to support 70,000-tag configurations](#) on page 13 for the system requirements.

As a best practice, Rockwell Automation recommends using a shared concurrent activation, which is locked to a networked activation server computer, but shared by client computers on the network. Refer to "About types of activations" in the FactoryTalk Help for more information.

Note that if you have multiple FactoryTalk Gateways using different tag counts, each FactoryTalk Gateway must be activated using its own specific activation file to ensure that each FactoryTalk Gateway receives the correct tag count activation.

**Tip:**
- FactoryTalk Batch v9.00.00 (CPR 9) and later supports FactoryTalk Live Data to communicate with plant-floor controllers and devices, replacing the need for using FactoryTalk Gateway.
Install FactoryTalk Gateway with command line syntax

Besides the Setup Wizard installation, FactoryTalk Gateway also supports automated installation using command line syntaxes: unattended installation. You can typically use the unattended installation during large-scale rollouts when it might be too slow and costly to have administrators or technicians interactively install the FactoryTalk Gateway software on individual computers.

In the unattended installation, you enter a specified command line with multiple parameters. During the installation process, instead of prompting you for installation and configuration information interactively, the process follows the parameters you specified in the command lines.

To install FactoryTalk Gateway in the unattended mode, follow the steps below. The steps may vary slightly. Follow the on-screen instructions that apply to your operating system.

1. Close all open Windows programs.
2. Open the Command Prompt window as administrator.
3. In the Command Prompt window, navigate to D:, where D: is the drive containing the FactoryTalk Gateway installation DVD or installation package, and press Enter.

   Tip: The User Account Control dialog box may show after you press Enter, click Yes to continue. The silent installation requires the Windows Administrator privilege.

4. Type a command line with the following syntax:

   
   ```
   ```

Perform unattended installation
5. Press Enter. The installation process starts with the parameters you specified.

6. For detailed description about each parameter, see Parameters on page 48. You can also type Setup /? in the Command Prompt window, and press Enter to view the help information of all parameters and examples.

**Parameters**

The parameters and values are not case sensitive. If the value includes spaces, you need to enclose it in quotation marks (" ").

/\Q

Required if /\QS is not specified.

Installs the product in the silent mode without any user interface.

/\QS

Required if /\Q is not specified.

Installs the product in the unattended mode without user interaction during installation, and shows the progress, errors, or complete messages on the user interface.

/IAcceptAl\l\LicenseTerms

Required. Specifies that you read and acknowledge all license agreements, and agree to continue the installation.

/AutoRestart

Optional. If specified, the computer will be restarted automatically after the installation, if a restart is required to complete the installation.

The parameter is ignored if a restart is not required.

/Setup\Language=\language

Optional. Specifies which language will be displayed during the installation process. The value must be the one of ENU, CHS, DEU, ESP, FRA, ITA, JPN, KOR, or PTB.

If omitted, the default language is the user or system user interface language.

/Product=\product name

Required. Specifies which product will be installed. The product name must be one of the following:
Install FactoryTalk Gateway with command line syntax

Gateway
Remote Gateway

/InstallDrive=drive

Optional. Specifies the installation drive.

If omitted, the default drive and location are:

- C:\Program Files (x86)\Rockwell Software (64-bit) or
- C:\Program Files\Rockwell Software (32-bit).

/SerialNumber=serial_number

Optional. Specifies the serial number that is required if you want to get activation keys during installation.

/ProductKey=product_key

Optional. Specifies the product key that is required if you want to get activation keys during installation.

/Version=product_version

Optional. Specifies the version corresponding to the product version that the SerialNumber and ProductKey are able to activate if you want to get activation keys during the installation.

If the version information is omitted, the installer uses a default version which is the most recent product version available when retrieving the activation.

Examples

The following examples show how to use the commands during the unattended installation.

Example 1

Setup.exe /Q /IAcceptAllLicenseTerms /Product="Gateway"

means:

The FactoryTalk Gateway unattended installation uses the default settings during the installation process, with no user interface.

Example 2

Setup.exe /QS /IAcceptAllLicenseTerms /AutoRestart
/SetupLanguage=CHS /Product="Gateway" /InstallDrive=D:
/SerialNumber=0123456789 /ProductKey=ABCDE-FGHIJ
/Version=3.90.00
means:

- During the installation, the progress, error, or complete messages show on user interfaces. The displayed language is Chinese.

- FactoryTalk Gateway version 3.90.00 will be installed to D:\Program Files (x86)\Rockwell Software if you are using a 64-bit operating system, or D:\Program Files\Rockwell Software if you are using a 32-bit operating system.

- The setup will get activation keys during installation if the serial number 0123456789 and product key ABCDE-FGHIJ are valid.

- After the installation, if a restart is required, the computer will be restarted automatically.
This appendix includes an overview of RSLinx Enterprise.

RSLinx Enterprise is a FactoryTalk Live Data™ server and FactoryTalk Alarms and Event server. RSLinx Enterprise is not an OPC server. FactoryTalk Gateway provides RSLinx Enterprise OPC connectivity for third-party clients.

RSLinx Enterprise configurations, which you create and modify using the Communication Setup editor, are used to communicate with devices (such as controllers and I/O scanners) on the plant floor. This enables you to see values, such as sensor readings and other controller data from your plant floor devices, on your desktop computer or dedicated PanelView Plus terminal.

An RSLinx Enterprise configuration consists of:

- A list of communication devices and their settings (for example, node, baud rate).
- Device drivers and their associated properties.
- A list of potential target devices with which RSLinx Enterprise can communicate (that is, exchange data).
- Shortcuts. A shortcut is a name that stands for the device you want to connect to and the data that device contains. The communication path associated with the shortcut tells the application where to find that data.

To begin using RSLinx Enterprise after you install it, you must first add it to a FactoryTalk application, which is created in a FactoryTalk Directory. This can be done within the FactoryTalk Administration Console or with FactoryTalk View Site Edition Stand-alone, FactoryTalk View Site Edition Distributed, or FactoryTalk View Machine Edition products.

For more information about RSLinx Enterprise, refer to the RSLinx Enterprise Help.
Secure FactoryTalk Gateway using FactoryTalk Security

This appendix includes the following information:

- About FactoryTalk Security
- Using FactoryTalk Security with FactoryTalk Gateway
- Securing tag write access for FactoryTalk Gateway

About FactoryTalk Security

FactoryTalk Security™ secures your automation system by limiting access to those with a legitimate need. FactoryTalk Security authenticates user identities and authorizes user requests to access a FactoryTalk-enabled system. These security services are fully integrated into the FactoryTalk Directory and are included as part of the FactoryTalk Services Platform that installs with many products.

For help configuring security services, refer to "Getting started with security" in the FactoryTalk Help.

If you prefer not to use security services, you can grant all users full access to your automation system. For help overriding security services, refer to the FactoryTalk Help.

Use FactoryTalk Security

FactoryTalk Security enables you to secure the FactoryTalk Gateway Configuration tool and runtime actions.

The FactoryTalk Gateway Configuration tool allows you to start or stop the FactoryTalk Gateway service and configure the scope. You configure security for the tool by right-clicking the network (the highest level of the tree) and selecting Security from the context menu.

To start or stop the FactoryTalk Gateway service, you must be either a Windows Administrator or Power User of the computer.

To configure the scope, you must have Read/Write/List Children permissions within the Common section of Security. You must also be logged in to FactoryTalk to be able to configure the scope. If you have not already done so, you will be prompted to log in when you click Configure.

For example, if you need to restrict a user from changing the scope:

2. From the Users list, highlight the user you want to restrict (must be a Windows Administrator or Power User to stop the service).

3. From the Permissions list, click **Common > Write**, and select the **Deny** check box.

4. Click **OK**.

### Secure runtime actions

Runtime actions are browsing, reading, or writing to tags. You configure security governing these actions using the Anonymous Logon user account at either the application level or area level.

**To browse the directory and read the data**, the Anonymous Logon user must have List Children and Read permissions within the Common section of Security.

**To write to tags**, the Anonymous Logon user must have Write Value permissions within the Tag section of Security.

Keep the following in mind when securing runtime actions:

- Security for the FactoryTalk Gateway is set at the FactoryTalk Gateway level using the Anonymous Logon user account. Therefore, all clients that access that specific FactoryTalk Gateway will have the same privileges. If different clients need different privileges, then a second FactoryTalk Gateway will need to be configured on another computer.

- Security is area-based. It is a best practice to have only one data server per area. This allows you to place different permissions on each area (data server).

- When configuring the scope for the FactoryTalk Gateway, you should select the FactoryTalk Application, not an area. Selecting the scope at the application level enables you to add areas to that application without having to change the scope. Changing a scope affects all the existing tag references that have been previously configured in the clients.

- You can deny both Read and Write access to areas. This is shown in the following example.

### Example
Assume a Network-scoped distributed system. This system has a FactoryTalk Application called MyFTApp that contains three areas and three data servers.

Network
  MyFTApp
   Area1
      RSLinx Enterprise
   Area2
      RSLinx Classic
   Area3
      FactoryTalk View SE HMI

Assume the requirements for the OPC clients are:

- Full access (Reads/Writes) allowed through RSLinx Enterprise.
- No Reads allowed from the OPC client through RSLinx Classic.
- No Writes allowed from the OPC client into the FactoryTalk View SE HMI (Reads are allowed).

To meet these requirements:

1. The selected scope (using the FactoryTalk Gateway Configuration screen) should be Network/MyFTApp. (Selected Scope field shows Network/MyFTApp.)

2. Security for Area1 (using the FactoryTalk Administration Console) should be configured as follows:
   a. Area1 > Security > Anonymous Logon > Common > Read > Allow
   b. Area1 > Security > Anonymous Logon > Common > List Children > Allow
   c. Area1 > Security > Anonymous Logon > Tag > Write Value > Allow

3. Security for Area2 (using the FactoryTalk Administration Console) should be configured as follows:
   a. Area2 > Security > Anonymous Logon > Common > Read > Deny

4. Security for Area3 (using the FactoryTalk Administration Console) should be configured as follows:
   a. Area3 > Security > Anonymous Logon > Tag > Write Value > Deny
If a write action is attempted into Area3, the following error is logged in FactoryTalk Diagnostics:

"FactoryTalk Gateway write failed due to denied access for client ‘Client1’ group ‘Group1 (Active, 250ms)’ item ‘Area3::my_int’. Verify you have the correct security authorization to perform the write operation."

If you attempt to browse the FactoryTalk application, Area2 will not show since Read permissions have been denied. If your display has a tag previously referenced from Area2, its value will show as (Empty Data) with a Quality of Invalid Quality. The following errors are logged in FactoryTalk Diagnostics:

"Cannot interpret area RNA://$Global/MyFTApp/Area2 (result=80042062)
Failed to add item ‘[FTI_Advanced]my_tag’ to server RNA://$Global/MyFTApp/Area2:RSLC’ because of insufficient access rights."

**Tip:** Access to resources (such as applications, areas, or servers) and the ability to perform tasks (such as read or write) are governed by the permissions set in FactoryTalk Security. As a result, if you do not have the appropriate permission, some components on a dialog box may be unavailable, or entire dialog boxes or context menu selections described in the Help may be inaccessible. Refer to the FactoryTalk Security Help for more information.

## Secure tag write access

The system administrator can control which FactoryTalk Gateway(s) have tag write access for an application, area, or sub-area using the Anonymous Logon user account. Tag write access is enabled (Write Tag permission is set to Allow) by default.

To limit tag write access for an application, area, or sub-area (this feature can be used if your FactoryTalk application contains one FactoryTalk Gateway):

1. On the FactoryTalk Administration Console **Application** tab, select the application, area, or sub-area.
2. Right-click and select **Security** from the context menu. The **Security Settings** dialog box opens.
3. Select **Anonymous Logon** from the list of users.
4. Click and expand **Tag** in the list of permissions to expose the Write Value permission.
5. Select the **Deny** check box.
6. Click **OK**.

The system administrator can also control write access for a specific computer. This feature can be used if your FactoryTalk application contains more than one FactoryTalk Gateway, and you want different levels of read/write permissions for each FactoryTalk Gateway.

To limit tag write access for a computer:

1. On the application window, select the application, area, or sub-area.

2. Right-click and select **Security** from the context menu. The **Security Settings** dialog box opens.

3. Click **Add...**. The **Select User and Computer** dialog box opens.

4. Select **Anonymous Logon** from the list of users. (If **Anonymous Logon** is not listed, select **Show users only**.)

5. Select the appropriate computer from the list. (If computers are not listed, select **Show computers only**.)

6. Click **OK**.

7. Click and expand **Tag** in the list of permissions to expose the **Write Value** permission.

8. Select the **Deny** check box.

9. Click **OK**.

Note: Attempts to write to tags when tag write access has been denied will generate a FactoryTalk Diagnostics error message.

Keep the following in mind when using Anonymous Logon:

- Located in **Users and Group > Users**.
- Password cannot be deleted or changed.
- Rights should be verified by checking the Effective permissions for the Anonymous Logon user. Refer to "About permissions" in the FactoryTalk Help.

For more information, refer to "Securing actions" in the FactoryTalk Help.
• **access path.** Used in OPC conversations to define the computer, driver, networks, and communication devices used to communicate with a destination device or processor.

• **activation file.** A digitally signed, plain-text file that activates a software product and locks the activation to a particular piece of hardware, such as a computer’s hard disk, Ethernet card, or dongle. The contents of an activation file are protected by a signature, generated by Rockwell Automation, which is based on machine-specific information that you provide when you install the software.

• **application.** Organizes project information, including elements such as data servers, HMI servers, and alarm and event servers, and makes it available to all software products and computers participating in a FactoryTalk system. See Network application, Local application.

• **area.** Organizes and subdivides a distributed Network application into logical or physical divisions. For example, separate areas may correspond with separate manufacturing lines in a facility, separate plants in different geographical locations, or different manufacturing processes. Areas are not available with Local applications.

• **client.** A component or subsystem that uses data or functionality provided by some other component or subsystem (the server). The term can also refer to the computer that executes this software, connecting to a server computer across a communication network.

• **communication tree.** A hierarchical representation of a network topology that is rooted at a specific RSLinx Enterprise server host device.

• **concurrent activation.** A floating, concurrent activation locks the software activation to the Host ID of an activation server. The activation server manages a pool of activations and loans them to client computers over a network connection.

• **configuration.** A file that contains information about the physical structure you defined for your system. This file includes all network paths, defined drivers and devices, Data Providers, and object protocols.

• **CPR.** Coordinated Product Release.

• **data server.** A server that serves tags, or data items, contained in OPC-DA (Data Access) servers.

• **data element.** An individually addressable item of data. For example, a tag (for example, OPC or HIM) or an HMI Project Component (for example, a graphic, event file, node, channel).

• **Data Provider.** Logic that knows how to speak to a particular class of products. One of the building blocks of RSLinx Enterprise, a Data
Provider acts as a multiplexor for multiple clients and optimizes what data can be read together for more efficient handling.

- **distributed application.** See Network application.

- **FactoryTalk Activation Manager.** A software program that manages activations for the Rockwell Automation products installed on the computer. You can run it from the Windows Start menu: **Start > Programs > Rockwell Software > FactoryTalk Activation > FactoryTalk Activation Manager.**

- **FactoryTalk Administrative Console.** A stand-alone tool used to configure and administer FactoryTalk applications. This tool may be used to perform such tasks as creating areas and data server elements, creating user accounts and user groups, configuring security permissions, and viewing system-wide diagnostic messages. FactoryTalk Administration Console installs along with most FactoryTalk-enabled software products.

- **FactoryTalk Diagnostics.** Provides the ability to log errors, warnings, and other status messages generated throughout a FactoryTalk-enabled system to a central location.

- **FactoryTalk Directory.** Provides a central lookup service for software products participating in a FactoryTalk-enabled automation system. The FactoryTalk Services Platform includes two separate directories: a Local Directory and a Network Directory. Either directory, or both directories, can be configured on the same computer. Project information, including security settings, cannot be shared between a Local Directory and Network Directory, even if both directories are configured on the same computer.

- **FactoryTalk Live Data.** A service that reads and writes tag values (OPC items) to or from any OPC-DA (OLE for Process Control - Data Access) or Live Data server on behalf of client software products such as FactoryTalk View Site Edition and FactoryTalk Transaction Manager.

- **FactoryTalk Security.** Formerly known as RSAsset Security. A set of security services integrated into the FactoryTalk Directory. Use FactoryTalk Administration Console or FactoryTalk View Studio to configure these security services.


- **floating activation.** A type of concurrent activation. Floating activations allow multiple computers across a network to use Rockwell Automation products concurrently. An activation server manages a
predetermined number of activations in a pool, and makes these activations available to any configured computer on the network.

- **GUI.** Graphical user interface.
- **HMI.** Human-machine interface.
- **HMI server.** The software module that is responsible for performing core run-time operations such as data collection, alarm detection, historical data logging and retrieval, and for providing FactoryTalk View SE clients with graphic, run-time data, and events.
- **Local application.** An application accessible only from the local computer where it resides. Even if the computer is connected to a network or a Network application resides on the same computer, the Local application remains self-contained and does not share its data or any of its project elements. Local applications do not support areas. Also called stand-alone applications.
- **Network application.** A software system that uses several interconnected computers that share information and processing duties to accomplish its tasks. A Network application organizes project elements from multiple FactoryTalk-enabled products. All of the computers participating in a particular application share a common FactoryTalk Directory located on a network computer. Also called a distributed application.
- **OPC.** A set of industry-standard specifications that define interfaces for communicating with automation devices and services. Applied OPC standards makes interoperability possible among automation and control applications, field systems and devices, and business and office applications that are supplied by different vendors.
- **OPC Test Client.** A utility that enables you to test your data connections if you are using remote OPC Client functionality. This utility is installed automatically as part of Remote FactoryTalk Gateway on the FactoryTalk Gateway product DVD.
- **packet.** The transmission unit exchanged at the network layer.
- **reference.** A link from one data element to another. The referring element is called the source element and the referenced element is called the target element. A graphic display, for example, typically reference tags, which supply it with runtime data.
- **Remote FactoryTalk Gateway.** Remote FactoryTalk Gateway enables an OPC client to access FactoryTalk Gateway on a remote computer without installing any Rockwell Automation products on this (local) computer. It installs the OPC Foundation components, the OPC Test Client, and all registry information needed to connect to the remote FactoryTalk Gateway.
- **RSLinx Enterprise.** RSLinx Enterprise is a FactoryTalk Live Data™ server and device-based alarm and event server. RSLinx Enterprise is not an OPC server. FactoryTalk Gateway provides RSLinx Enterprise OPC connectivity for third-party clients.
- **server.** A subsystem that provides services for clients via a set of interfaces.

- **scope.** The application, areas, and sub-areas from which you want to access data.

- **shortcut.** Represents a device that you want to connect to on the network and the data that device contains. The communication path associated with the shortcut tells the application where to find that data. This symbolic reference to a physical device is similar to a topic in RSLinx Classic.

- **tag.** An individually addressable item of real-time data. For example, a tag can represent a process variable in a Logix5000 controller.

- **topology.** The way a network is physically structured. This includes all networks, nodes, devices, Data Providers, drivers and channels, and object protocols. In RSLinx Enterprise, this is presented in tree form (the Communication tree).

- **workstation.** A FactoryTalk Services Platform-enabled personal computer.
**Index**

<table>
<thead>
<tr>
<th>A</th>
<th>FactoryTalk Services Platform 10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FactoryTalk, basic concepts 10</td>
</tr>
<tr>
<td>accessing data 30</td>
<td></td>
</tr>
<tr>
<td>activations, about 43</td>
<td></td>
</tr>
<tr>
<td>Anonymous Logon 56</td>
<td></td>
</tr>
<tr>
<td>applications, about 11</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>hardware requirements 13</td>
</tr>
<tr>
<td>consulting services 8</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>installing FactoryTalk Gateway 13, 18</td>
</tr>
<tr>
<td>data</td>
<td>Installing FactoryTalk Gateway 13, 18</td>
</tr>
<tr>
<td>accessing 28, 30</td>
<td></td>
</tr>
<tr>
<td>bad quality or none 38</td>
<td></td>
</tr>
<tr>
<td>DCOM 40</td>
<td></td>
</tr>
<tr>
<td>Diagnostics Counter Monitor about 31</td>
<td></td>
</tr>
<tr>
<td>running 33</td>
<td></td>
</tr>
<tr>
<td>using to troubleshoot FactoryTalk Gateway 35</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Knowledgebase 8</td>
</tr>
<tr>
<td>FactoryTalk Activation 11</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Administration Console 11</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Diagnostics 11, 37</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Directory 10</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Gateway activating 43</td>
<td></td>
</tr>
<tr>
<td>activations 44</td>
<td></td>
</tr>
<tr>
<td>Configuration dialog 23</td>
<td></td>
</tr>
<tr>
<td>installing 18</td>
<td></td>
</tr>
<tr>
<td>Quick start 11</td>
<td></td>
</tr>
<tr>
<td>Scope Selection dialog 25</td>
<td></td>
</tr>
<tr>
<td>securing 53</td>
<td></td>
</tr>
<tr>
<td>starting 23, 27</td>
<td></td>
</tr>
<tr>
<td>system requirements 13</td>
<td></td>
</tr>
<tr>
<td>troubleshooting 37</td>
<td></td>
</tr>
<tr>
<td>troubleshooting tools 37</td>
<td></td>
</tr>
<tr>
<td>updating an existing installation 20</td>
<td></td>
</tr>
<tr>
<td>where to install 16</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Gateway Configuration dialog box 23</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Gateway Scope Selection dialog box 25</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Live Data 11</td>
<td></td>
</tr>
<tr>
<td>FactoryTalk Security 11, 53</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Local applications 11</td>
</tr>
<tr>
<td>I</td>
<td>Network applications 11</td>
</tr>
<tr>
<td>K</td>
<td>Prerequisite software 15</td>
</tr>
<tr>
<td>L</td>
<td>OPC Test Client 38</td>
</tr>
<tr>
<td></td>
<td>Release Notes 8</td>
</tr>
<tr>
<td>P</td>
<td>Remote FactoryTalk Gateway, installing 20</td>
</tr>
<tr>
<td>R</td>
<td>RSLinx Enterprise, about 51</td>
</tr>
<tr>
<td>S</td>
<td>scope, selecting 28</td>
</tr>
<tr>
<td></td>
<td>securing tag write access 56</td>
</tr>
<tr>
<td></td>
<td>about 31</td>
</tr>
<tr>
<td></td>
<td>creating 34</td>
</tr>
<tr>
<td></td>
<td>software compatibility 15</td>
</tr>
</tbody>
</table>
Index

software requirements 14
starting FactoryTalk Gateway 23, 27
system requirements 13

T

tag write access, securing 56
Test Client 38
training programs 8
troubleshooting 37
    communications slow or unreliable 38, 40
data quality 38
    FactoryTalk Gateway activations 38
    starting and stopping service 38
troubleshooting tools 37
troubleshooting topics 38

U

updating an existing FactoryTalk Gateway 20
Legal Notices

Copyright Notice

© 2016 Rockwell Automation, Inc. All rights reserved.

This document and any accompanying Rockwell Software products are copyrighted by Rockwell Automation, Inc. Any reproduction and/or distribution without prior written consent from Rockwell Automation, Inc. is strictly prohibited. Please refer to the license agreement for details.

End User License Agreement (EULA)

You can view the Rockwell Automation End-User License Agreement ("EULA") by opening the License.rtf file located in your product's install folder on your hard drive.

Trademark Notices

Allen-Bradley, ControlLogix, FactoryTalk, Rockwell Automation, Rockwell Software, RSLinx, RSView, the Rockwell Software logo, are registered trademarks of Rockwell Automation, Inc.

The following logos and products are trademarks of Rockwell Automation, Inc.:

Other Trademarks


Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

OLE for Process Control (OPC) is a registered trademark of the OPC Foundation.

ControlNet is a registered trademark of ControlNet International.

DeviceNet is a trademark of the Open DeviceNet Vendor Association, Inc. (ODVA)

Oracle, SQL*Net, and SQL*Plus are registered trademarks of Oracle Corporation.

All other trademarks are the property of their respective holders and are hereby acknowledged.

Warranty

This product is warranted in accordance with the product license. The product’s performance may be affected by system configuration, the application being performed, operator control, maintenance, and other related factors. Rockwell Automation is not responsible for these intervening factors. The instructions in this document do not cover all the details or variations in the equipment, procedure, or process described, nor do they provide directions for meeting every possible contingency during installation, operation, or maintenance. This product’s implementation may vary among users.

This document is current as of the time of release of the product; however, the accompanying software may have changed since the release. Rockwell Automation, Inc. reserves the right to change any information contained in this document or the software at any time without prior notice. It is your responsibility to obtain the most current information available from Rockwell when installing or using this product.

Environmental compliance

Contact Rockwell

Customer Support Telephone — 1.440.646.3434
Online Support — http://www.rockwellautomation.com/support
Rockwell Automation support

Rockwell Automation provides technical information on the web to assist you in using its products. At http://www.rockwellautomation.com/support you can find technical and application notes, sample code, and links to software service packs. You can also visit our Support Center at https://rockwellautomation.custhelp.com for software updates, support chats and forums, technical information, FAQs, and to sign up for product notification updates.

In addition, we offer multiple support programs for installation, configuration, and troubleshooting. For more information, contact your local distributor or Rockwell Automation representative, or visit http://www.rockwellautomation.com/services/online-phone.

Installation assistance

If you experience a problem within the first 24 hours of installation, review the information that is contained in this manual. You can contact Customer Support for initial help in getting your product up and running.

<table>
<thead>
<tr>
<th></th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States or Canada</td>
<td>1.440.646.3434</td>
</tr>
<tr>
<td>Outside United States or Canada</td>
<td>Use the Worldwide Locator available at <a href="http://www.rockwellautomation.com/locations">http://www.rockwellautomation.com/locations</a>, or contact your local Rockwell Automation representative.</td>
</tr>
</tbody>
</table>

New product satisfaction return

Rockwell Automation tests all of its products to ensure that they are fully operational when shipped from the manufacturing facility. However, if your product is not functioning and needs to be returned, follow these procedures.

<table>
<thead>
<tr>
<th></th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>Contact your distributor. You must provide a Customer Support case number (call the phone number above to obtain one) to your distributor to complete the return process.</td>
</tr>
<tr>
<td>Outside United States</td>
<td>Please contact your local Rockwell Automation representative for the return procedure.</td>
</tr>
</tbody>
</table>

Documentation feedback

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete the feedback form, publication RA-DU002